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Digital Dave
“Digital Dave answers your tech questions.” by Digital Dave

Ivy Bridge Processor?; Watch Those Browser Add-ons.

Dear Digital Dave,

Recently | overheard a couple of nerds in the office talking about "lvy Bridge" processors. I'm
curious about what they are, but didn't want to show my ignorance. Is it something the average
computer user should know or is it just for geeks?

Jim
Dear Jim,

lvy Bridge is the code name for the latest round of Intel processors. It is replacing the Sandy Bridge technology and is
appearing in computers now on the shelf. If you're buying a new computer, then it is useful to know the difference
between the two technology. (Plus, you will be able to impress your friends and talk to nerds.) The older Sandy Bridge
computers will likely be less expensive while they are clearing out stock and being replaced with the Ivy Bridge
computers.

The difference between the two technologies is based upon shrinking the distance between the transistors in the
processor. The smaller the distance between the transistors, the more can be packed into a chip for greater
computing power. The Ivy Bridge processors have managed the drop from a spacing of 32 nanometers to 22
nanometers by introducing a three dimensional transistor Intel calls a Tri-gate (see Figure 1). It has enabled the
processor to give 20% more processing power while using an average of 20% less power over comparable Sandy
Bridge processors. Eventually, the vy Bridge technology is expected to be used in all levels of computing from high-
powered servers to smartphones. When the mobile version is ready it could give ARM processors a run for their
money in mobile computing.
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Figure 1. The Ivy Bridge Tri-gate (right) uses a 3D fin to achieve the closer transistor spacing while the Sandy Bridge is flat (left).

How to Identify Ivy Gate Computers

Unfortunately, the name Ivy Bridge may not appear on the specifications for a new computer. It is more likely to be
listed as "3rd Generation Core Processor" (while Sandy Gate is 2nd generation). To add to the confusion, the Intel i5
and i7 processor names will continue in use for both Ivy Bridge and its predecessor Sandy Bridge. However, the Ivy
Bridge model numbers are in the 3000 range (the 2000 range is assigned to Sandy Bridge). For example, a i7-3610
processor (www.amazon.com/gp/product/B0072J3JL6/ref=as_li_ss_tl?ie=UTF8) would use the Tri-
gate 3D technology.

lvy Bridge Performance

While you will see increased performance in all computing tasks, there should be greater improvement in high-def
game playing, multimedia and video processing (touted as up to twice as fast). The new chip includes the speedy
USB 3.0 which is now rapidly replacing the slower USB 2.0, the standard for the last ten years.

There will be many variations (size and number of cores) of the Ivy Bridge processors with the lighter, less power-
hungry versions targeted at the mobile market (coming out later in 2012 or early 2013). When installed on a tablet
computer, these mobile processors may be an idea match for a new Microsoft Windows 8 version which includes the
complete Windows Desktop interface. That could bring all of Windows to a tablet computer which could be difficult
with an ARM processor.

Do you need to look for Ivy Bridge when buying a new computer? Most people who do regular computing will never
notice a difference between Ivy Bridge and Sandy Bridge. However, the power users (gamers in particular) are
already looking closely at the new processor and benchmarks—which in most cases have only shown a ten percent
increase in performance.
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If you're in the market for a new computer and you can get the new processor without it costing too much more, then
why not? However, depending upon your needs, if sticking with Sandy Bridge will save you money (and you don't
need the added processing power or lower power consumption), then a new Sandy Bridge computer will serve you
well for many years. (There are rumors that Apple will soon be releasing Mac products using Ivy Bridge processors.)

Digital Dave

Digital Dave’s Tip

As | was working on this week's letter | noticed some strange behavior in Google Chrome. | was reviewing the
drawings of the transistors when there was suddenly a list of offers tagged to the bottom of the picture (see Figure 2).

Figure 2. Picture from letter with amazing offers attached.
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Normally | would put it down to the Web site and move on, but this time | was working on the ComputorEdge site
with software written by Jack Dunning. It couldn't be coming from the Web site.

| tried the same thing with a different computer and sure enough there was no problem. It had to be either my browser
or something related to the computer.

| opened Tools => Extensions (see Figure 3). There was an add-on | had never seen before called AP Suggestor. |
unchecked the Enable box (circled in red). The problem went away.

Figure 3. Unrecognized extension in Google Chrome.

| don't know how the extension got there. Probably when | was downloading one of the many programs | review.
However, | thought it was worth passing on.

Sometimes when we see funky advertising we blame it on the Web site while the problem is actually in our own
browser. You should occasionally check your extensions and add-ons to make sure you don't have any unwanted
extras. If you don't recognize an extension, you may not need (or want) it. It is rare that a Web browser extra is ever
necessary.

If you suspect a browser problem, you can also check it out by switching to another browser—say Firefox. If the
problem continues, it's likely the Web site. If you don't see the same occurrence, it's likely an issue with the original
browser—although it could also be some sort of malware on your computer.

Digital Dave
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My Favorite Free Screencast Program
“Make Your Computer Training Video” by Jack Dunning

Some people point a video camera at the computer screen to capture the digital action. With this free software you can record
directly from your computer.

These days virtually everyone is making home movies. Many are using their smartphones, but almost any digital
camera will also take videos. These shorts can be posted to YouTube, Facebook and any of a number of other Web
sites. In many cases the video is added to the Web without any editing. (YouTube has basic editing functions which
allow the addition of titles, splicing, transitions, and even music.) This is great if you're posting video clips from a
camera, but what if you want to make a video of your computer screen action? By far, the best way to do this is with
video capture software or screencast programs. Similar to screen image capture programs such as Windows Snipping
Tool, screencast software records everything that you do on your computer while in the record mode.

Screencasting is ideal for capturing the activity on
a computer screen. You may want to do this for a
training aid or maybe you want to record a
problem you're having. There are many videos
posted where digital cameras were used to record
screen activity, but it is so much easier (and
cleaner) to record your screen with your computer.

There are a number for programs available for
screencasting, but most of them will cost you. If
your primary goal is to get a good copy of your
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computer screen in action, then you won't do
better than CamStudio (download.cnet.com/
CamStudio/3000-13633_4-10067101.
html?tag=mncol;1). (One caution about
downloading CamStudio from CNET. CNET has
now added a special downloader which tries to
add other software to your computer system. To
avoid this use the link below the Download button. See Figure 1.) While not as capable as its commercial counter
parts, CamStudio does an excellent job of screen video capture. Camtasia Studio (www.amazon.com/gp/
product/BOO3F4XPWS8/ref=as_li_ss_tlI?ie=UTF8&tag=comput0b9-20) is one of the best known
commercial programs and it has many enhancements and editing tools not found in CamStudio. If you're planning to
become a professional screencaster, then Camtasia may be worth the $300 investment. For me, recording with the
free CamStudio and editing in a free video editor such as Windows Movie Maker is all that | need. (For a sample video
see "Window 8 Made Simple (www.youtube.com/watch?v=qcUHBYAS_n0)" on YouTube.)

Figure 1. To avoid adding unwanted software to your Windows computer, at CNET use the direct download link (circled in red).

While I have tried some other video capture programs, I've found CamStudio exceptionally easy to use. (I did discover
that if | tried too many fancy tricks in Windows 7, | could experience problems with CamStudio. If | stuck with recording
the AVI format files, it work well.) CamStudio is limited to saving in two video formats, AVI being the primary format.
Sites such as YouTube will not accept AVI, but it is easy to convert the file to an acceptable format such as Windows'
WMV. Just add the AVI to Windows Movie Maker, then save it in the Windows format which can be uploaded to
YouTube.

The AVI files may be quite large. You should have a computer with plenty of memory and a large hard drive. A two-
minute AVI video is about 250MB. Once compressed to a WMV file, it is only 15MB.

The CamStudio screen has a small footprint as shown in Figure 2. The primary buttons are the red Record button, the
gray Pause button, and the blue Stop button. To start copying your computer screen, it's as simple as clicking the red
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Record button. Click the blue button to Stop.

Figure 2. The Record, Pause and Stop button are readily available on the main screen in CamStudio. To toggle to the Record to
AV, click the "swi" button.

There are a number of options for recording selected areas of your computer screen (see Figure 3). Region allows you
to select the area with your mouse after you click Record, but before it starts recording. Fixed Region allows the
designation of a fixed portion of the computer screen. Window allows the selection of an open window when Record is
clicked. Full Screen is self-explanatory. Since | run Windows 8 in a virtual machine, the Window mode worked best for
me when making Windows 8 videos.
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Figure 3. There are four modes in CamStudio for selecting the portion of the screen to be recorded.

One of the most useful features in CamStudio is Cursor Options (see Figure 4). The cursor can be changed to another
icon while recording. This is important since on replay the cursor, if left at its original shape and size, can be very
difficult to see. Optional icons include books, paper clips, clocks, files, folders, mail, pens, pencils, phones and more.

12 of 48



ComputorEdge 6/1/12

Figure 4. The Cursor Options in CamStudio allows the cursor to be changed to an icon which is easier to see and possibly more
appropriate.

The program even allows separate highlighting for surrounding the new cursor icon (see Figure 5). The highlighting
can be set to change color when the mouse button is clicked.

13 of 48



ComputorEdge 6/1/12

Figure 5. It's easier to see the cursor when the icon is changed to a different, larger image and highlighted.

Screen Annotations (found in the Tools menu) can be added to the video. The annotations are graphics which may
contain tailored text. They will stay always-on-top on the computer screen while activated and CamStudio is open.
They may be added to the screencast while recording or included in layouts which can be activated during the
recording session (see Figure 6 and Figure 7).

Figure 6. The annotation for the Windows Desktop Metro Tile is a separate graphic sitting always-on-top during the recording
session.
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Figure 7. When a layout is changed in the Screen Annotations window, the objects will change to the new layout.

While recording a video of your computer screen is easy, making a good instructional video to post to the Web may not
be. Although some people are video naturals, explaining what you are doing in a clear voice while operating a mouse
and a keyboard can be both confusing and awkward. It could be better to record the screen video without sound and
later add the audio. In any case, it may be useful to write a script in advance. Record the video with the proper number
of steps, possibly adding the screen annotations, then transfer the video clip to your movie maker program. Then
adding the audio, transitions, titles and labels will be easier while giving a more professional product.

(One more video with "Joe's Tip for Windows 8 Desktop Quick Launch (www.youtube.com/watch?
v=IhTaLbbSEM4)" on YouTube.)

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first issue on May 16, 1983.
Back then, it was called The Byte Buyer. His Web site is www.computoredge.com. He can be reached at
ceeditor@computoredge.com. Jack is now in the process of updating and compiling his hundreds of articles and
columns into e-books. Currently available:

Just released and available from Amazon, Misunderstanding Windows 8: An Introduction, Orientation,
and How-to for Windows 8 (www.amazon.com/gp/product/B007RMCRH8/ref=as_li_ss_tI?
ie=UTF8&tag=comput0b9-20)! Also available at Barnes and Noble (www.barnesandnoble.com/w/
misunderstanding-windows-8-jack-dunning/1109995715?ean=2940014229463) and ComputorEdge
E-Books (www.computoredgebooks.com/Windows-Tips-and-Tricks _c4.htm?sourceCode=writer).
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Available exclusively from Amazon, Windows 7 Secrets Four-in-One E-Book Bundle (www.amazon.com/gp/
product/B00801M5GS/ref=as _li_ss_tI?ie=UTF8&tag=computOb9-20),

Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using Windows 7
(www.amazon.com/gp/product/B007AL672M/?&tag=computOb9-20),

Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7 (www.amazon.com/gp/product/B00758J4L6/ref=as_li_ss_tI?ie=UTF8&tag=comput0b9-20),

and That Does Not Compute! (www.amazon.com/gp/product/B0052MMUX6/ref=as_li_ss_tI?
ie=UTF8&tag=comput0b9-20), brilliantly drawn cartoons by Jim Whiting for really stupid gags by Jack about computers
and the people who use them.
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Macintosh OS X Lion Tips v.2
“Ten of Lion's Lesser Known New Features” by Barry Fass-Holmes

Making the user even more productive and the experience of working on a Mac even more enjoyable.

Mac OS X Lion's marquee new features (www.apple.com/macosx/lion/)—Auto Save, File Vault 2, Full
Screen, gestures, LaunchPad, Mission Control, Resume and Versions—are well-publicized (www.
macworld.com/article/161026/2011/07/osx_lion_review.html) on the Web. These features are designed to
enhance the user's experience in working on a Mac.

In a previous article, we looked at 10 of Lion's lesser known new features—recent items in Dock
icons' contextual menu, the Print dialog's Pages pop-up menu, Spotlight's Quick Look preview
and path, secure empty trash, three-finger tap to display a word's definitions, iCal's three different
Get Info windows, select and copy text in Quick Look windows, About This Mac's More Info
window, Mail's action toolbar, and Safari 5.1.3 no longer asks you whether you really want to quit
after you select File > Quit.

This article will describe an additional ten of Lion's lesser known new features that potentially
could make the user even more productive and the experience of working on a Mac even more
enjoyable.

1. Available Only Via Apple's App Store; $29.99

Apple is making software packaging obsolete. Beginning with Lion, the only place where you can
purchase copies of OS X separately from a new Mac is the online App Store. Odds are that some
readers will roar that Apple is depriving users of choices, and they'd be correct in this case. Just
think, however, of the time, gasoline and trees saved by purchasing software online instead of
driving to a brick-and-mortar store to get a cardboard box containing a disc that someday soon
will be useful as a coaster and a paper insert with minimalist instructions.

What is the monetary cost of upgrading to Lion (itunes.apple.com/us/app/os-x-lion/id444303913?mt=12) via
the online App Store? Users upgrading from Snow Leopard will pay Lion's $29.99 price (see
Figure 1). Users upgrading from from Leopard will pay Snow Leopard's $29.00 price plus $29.99
for Lion.

17 of 48



ComputorEdge 6/1/12

Figure 1. OS X Lion is available only from Apple's online Mac App Store, and its price tag is $29.99.

2. Older Macs Need Not Apply
Lion requires a modern Macintosh (support.apple.com/kb/HT4949), namely one with Intel's Core 2

Duo, Core i3, Core i5, Core i7, or Xeon CPU. Any model Mac with an Intel Core Duo or Solo
CPU, or one with a PowerPC CPU is stuck at an older version of OS X.

18 of 48



ComputorEdge 6/1/12

Figure 2. Is your Mac Lion-ready?

To find out whether your Mac is qualified for Lion, select Apple Menu > About This Mac from the
menubar. The window that displays on screen will show the processor and amount of RAM in
your Macintosh (see Figure 2). If your Mac is among the unsupported older models, it is time to
consider whether it still meets your needs. If it does, you can continue using that Mac with the
installed version of Mac OS X until it stops meeting your needs; or you can save up for a brand
new model that will come with Lion (or Mountain Lion, the next major version of OS X beginning
some time this summer) preinstalled.

3. Show All Windows (App Exposé)

This has become one of my favorite new features in Lion. If you right-click, control-click, or two-
finger tap the Dock icon of an app that currently is running, the contextual menu that displays on
screen contains a Show All Windows option. Select, click, or tap Show All Windows in the
contextual menu and your Mac's screen shifts into Exposé mode for that particular app (see
Figure 3). This mode hides the menubar and Desktop (but not the Dock), displays previews of
that app's currently open files' windows, and displays a horizontally scrollable arrangement of
icons corresponding to files you've recently opened or created in that app. Very handy eye candy!
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Figure 3. Lion's Show All Windows option in the contextual menu of active apps' Dock icons (insert, upper

right corner) displays large previews of currently open windows and a horizontally scrollable arrangement

of recently opened files' icons. Single-click any of the scrollable icons and that file automatically opens in
the app.

Show All Windows also can be activated by a user-defined keystroke, four-finger swipe down on
a trackpad, or by configuring one of the screen's hot corners in Mission Control's System
Preference.

The contextual menu option Show All Windows for currently running apps is replaced by Show
Recents for apps that are not currently running. If you select Show Recents from an inactive
app's Dock icon or double-tap the icon, your Mac's screen similarly shifts into Exposé mode for
that particular app except it displays only the recent files' icons in a horizontally scrollable
arrangement (no large previews are displayed because the app isn't running, hence no
documents are currently open). For visual users, this feature might be preferable to launching an
app, then selecting File > Open Recent from its menubar.

4. Special Characters

Emoticon lovers probably will enjoy the wide diversity of emotion-oriented graphics in Lion's
Special Characters window (Figure 4). Instead of typing a string of ASCII characters to express
your inner feelings, such as :0) to represent a smiley face or :O( to represent a frowny face,
select Edit > Special Characters... from the menubar in just about any app. In the window that
displays, single-click Emoji in the left-most pane, then single-click People from the second pane
that displays. Double-click whichever icon expresses your feelings and it will be automatically
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inserted at the cursor's current location in the currently active app's active window.

Figure 4. Lion includes a wide range of emoticons for users to express themselves.

Note: you can drag-and-drop characters in other character sets from the Special Characters
window to the currently active app's currently active window, but you cannot drag-and-drop Emaoji
characters (at least within the scope of my testing).

5. View iWork and Office Documents Without Installing Either

Suppose a friend, relative, or co-worker gives you a file created in one of iWork's or Microsoft
Office's suite of programs (Pages, Numbers, or Keynote; Word, Excel, or PowerPoint) and your
Mac doesn't have that program installed. How are you supposed to see what's in the file?

With Lion, you can inspect almost any Office or iWork document by opening it in the Preview
program located in the Applications folder (see Figure 5). Simply drag and drop the desired file on
Preview's icon (or select File > Open from Preview's menubar and navigate to the desired file in
the Open File dialog that displays). Note that the file is only readable, not editable, in Preview.
However, you can copy-paste the file's contents to another program for editing.

21 0of 48



ComputorEdge 6/1/12

Figure 5. Lion's Preview app gains support for opening and displaying (but not editing) iWork and
Microsoft Office documents.

6. Group As Folder

Suppose you have several files that you want to include in a new folder. In previous Mac OS X
versions, you would need to perform the following steps.

1. In the Finder, create a new folder (e.g., select File > New Folder from the Finder's menubar),
type the desired name for the new folder, and press Return.

2. Select the files that you want to move into the new folder.
3. Move the files to the new folder (e.g., drag-and-drop).

In Lion, the above process is streamlined thanks to Lion's new Group As Folder feature. This
feature is found within the Finder's contextual menu for selected files. To use this feature,
perform the following steps.

1. In the Finder, select the desired files to include in a new folder.

2. Right- or control-click the selection and select New Folder with Selection from the contextual
menu that displays.
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3.Type the desired name for the new folder and press Return.

4. Presto, you're done (see Figure 6).

Figure 6. Lion's New Folder with Selection contextual menu option (A) streamlines the steps required to
create a new folder containing a group of selected files (B).

7. All My Files

Lion's Finder has a new way for users to display their account's documents. This feature is called
All My Files, and it displays all the files in a user account within a single Finder window regardless
of where they're located. The display is limited, however, to routinely used files—documents, iCal
items (events; to dos), PDFs, images, videos, etc.—but excludes system files.

All My Files contains rows of categorized files' icons (i.e., images in one row, PDFs in another,
and so on) that are horizontally scrollable. The user can customize the display's arrangement by
selecting an option from the display's contextual menu (as shown in Figure 7).
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Figure 7. Lion's Finder provides a new way to navigate through the file system called All My Files. It
displays all of your files as icons organized into rows within in a single window which are horizontally
scrollable and user customizable via a contextual menu.

8. System Info's Graphical Display of Hard Disk Space

The hard drives attached to and/or within today's Macs are humongous compared with
counterparts in yesteryear's Macs. They have become easy to fill up with image, music and/or
video files that users purchase and/or download freely from the Web.

To visualize how much hard drive space these categories of files are occupying, Lion's About
This Mac window includes a graphical display of hard disk usage and free space. This display is
similar to the one included in iTunes showing a connected iDevice's usage and free space (see
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Figure 8).

Figure 8. Lion's About This Mac window includes a graphical display of used and free space for your
Mac's hard drive (A) similar to iTunes' corresponding display of used and free space for your iDevice (B).

9. Quick Look in Open File Sheets and Dialogs

Suppose you want to work on a file in a particular app, but you have several files with similar
names and you're not sure which is the one that you want to work on. You could open all of them
in the app and inspect each one in turn, or you could use Lion's new support for Quick Look in
Open File sheets and dialogs.

This feature is very easy to use. After selecting File > Open from the menubar (or pressing
command-o on your Mac's keyboard) in almost any program, navigate in the Open File sheet or
dialog to the folder that contains the file of interest. After single-clicking the file, press the
keyboard's spacebar and voila—the file's contents are displayed in a Quick Look window (Figure
9). You then can inspect the contents to determine whether that file is the one you want to work
on. Otherwise, you can use the keyboard's arrow keys to scroll to other files and their contents
will display in the Quick Look window.
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Figure 9. Files you select in Lion's Open File sheets and dialogs are previewed in a Quick Look window
after you press the keyboard's spacebar, so you can make sure which file really is the one you want
before opening in the current app.

10. New Boot Camp Version

Boot Camp 4.0 (www.apple.com/support/bootcamp/) is the new version included with Lion (see Figure
10). What's Boot Camp? It is Apple's technology for installing Windows and related hardware
drivers on Intel-based Macs. It creates a separate partition on the target Mac's hard drive so that
the user can choose whether to boot into the installed version of Windows or OS X.

The new featurese (support.apple.com/kb/HT4818%233) in Lion include the following.

* Online availability

* Supports Windows 7 Home Premium, Microsoft Windows 7 Professional, and Microsoft
Windows 7 Ultimate, but not Vista or XP

» Can create a CD or USB media to install the latest Boot Camp drivers for your computer
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» Supports for Windows 7's ISO installer

» Supports Windows via installer disc or USB flash drive that contains a Windows 7 ISO image
downloaded from Microsoft

» Upgrades or clean installs Windows without using Boot Camp Assistant

Figure 10. Lion's Boot Camp 4.0 is a new version that makes Windows installation on an Intel-based
Macintosh easier than before. However, it only supports flavors of Windows 7 (forget about Windows XP
or Vista).

Here's a bonus tip for good measure—Lion drops Rosetta (www.macrumors.com/2011/06/13/0s-x-lion-to-
drop-rosetta-support-for-powerpc-applications/) support. What's Rosetta? It is Apple's emulator (docs.info.
apple.com/article.html?artnum=303120) for Macs equipped with Intel chips that runs programs written

for Macs equipped with PowerPC chips (the old G5 and G4 PowerMacs, for instance). Lion does
not include Rosetta (reviews.cnet.com/8301-13727_7-20085006-263/g-a-macfixit-answers-lion-edition/?tag=mncol;
titte) and Snow Leopard's version does not function properly if you install it in Lion.

Because Rosetta support has been dropped in Lion, programs written for the obsolete PowerPC
chips do not launch under Lion. Instead, their icons are dimmed with a superimposed prohibitory
sign (see Figure 11). If you double-click such a program icon, an error alert displays that indicates
the program's incompatibility with Lion.
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Figure 11. Programs written for the obsolete PowerPC chips in older Macs (e.g., PowerMacs,
PowerBooks, etc.) were supported in previous Mac OS X versions thanks to Apple's Rosetta technology.
This technology has been removed from Lion and cannot be properly added with Snow Leopard's
Rosetta installer.

So there you go...10 plus 1 tips for 10.7 (Lion). Better start taking advantage of these tips ASAP
now that 10.8 (Mountain Lion) (www.apple.com/macosx/mountain-lion/features.html) is just around the
corner.

Barry Fass-Holmes has been reviewing products for ComputorEdge since 2003. He previously
worked as a software support representative and quality assurance analyst in San Diego. His
product reviews are available in ComputorEdge's archives and at his Web site (www.barrythphd.comy/).
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Wally Wang's Apple Farm
“Eliminate the Middleman” by Wally Wang

Eliminate the Middleman; Save Your Storage Space; Bargain Priced
Apps; More Dinosaurs Sinking in the Tar Pits; More 3D Printing News;
Font Size in Safari.

The biggest changes occur when you eliminate the middleman. E-mail and online electronic bill
paying reduced the need for the post office, video streaming and renting DVDs by mail or vending
machines killed Blockbuster Video, digital photography wiped out Kodak's film processing
business, e-books killed Borders Bookstores, and MP3 files and iTunes wiped out the CD music
stores like Tower Records. If you're in an industry that thrives as a middleman between the
consumer and the manufacturer, your days are numbered.

Amazon, which has already disrupted the online commerce and book publishing industry, now
offers yet another way to disrupt the middleman. In the old days, the big television networks
(ABC, CBS, and NBC) dictated what people could watch on TV. In the movie industry, a handful
of studios like Warner Brothers and Paramount effectively served as gatekeepers to making
movies. The cost of both TV and movie production remained so high that only large corporations
could afford the risk in making television shows or movies.

Now with inexpensive digital video cameras, the costs of production have come down and the
stranglehold of control has been loosened. While everyone waits for rumors of Apple's TV to
appear and disrupt the television industry, Amazon is already threatening the studios and
networks with their Amazon Studios (news.cnet.com/8301-1023_3-57438541-93/how-amazon-is-changing-the-
rules-for-books-and-movies/?tag=mncol;topStories) program.
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Figure 1. Amazon Studios gives everyone a chance to pitch a TV series or movie.

In the old days if you had a good idea for a TV series or a movie, you had to pitch your idea to a
network or studio executive, who either approved it (green lighted it) or rejected it. In most cases,
executives would take good ideas and "develop” them, which sometimes meant improving it, but
often meant wrecking the premise beyond its original intent as a dozen executives attempt to
change a project to justify their own involvement and take credit for its success.

Science fiction writer Harlan Ellison once worked on a science fiction TV series where he
complained that the executives thought that the starship's backup systems made the starship go
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in reverse. Michael Crichton, the author of Jurassic Park (www.amazon.com/gp/
product/0345370775/ref=as_li_qf sp_asin_tl?ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0345370775), once remarked that
Hollywood executives were "dumber than a rock."

To avoid the typical gauntlet of getting a TV series or movie approved through Hollywood
(assuming you can even get a meeting with any Hollywood executives in the first place), Amazon
Studios lets anyone submit a screenplay or a TV series pilot script. If Amazon thinks your project
shows promise, they'll pay you $10,000 to put your project through a development phase. Now
you can solicit ideas from others and improve your screenplay or TV series. If Amazon likes the
improved project, they might pay you $200,000 to turn it into an actual movie through their
partnership with Warner Brothers Studios, or pay $55,000 to turn it into a TV series to air
exclusively on Amazon's Instant Video service.

Amazon Studios is guessing that people all over the world have great ideas for a TV series or
movie that Hollywood would otherwise ignore. Of course, Amazon has an ulterior motive. With
video streaming growing in popularity, companies like Amazon, Netflix and Hulu are basically
streaming the exact same movies and TV shows. By helping develop new media content,
Amazon Studios can develop new TV shows and movies that they can offer exclusively through
Amazon. With more exclusive content, Amazon can then attract more video streaming customers.

In the old days, the money was in the hardware. Nowadays, the money lies in the content that
makes the hardware useful. One reason why Dell recently missed financial forecasts (blogs.barrons.
com/techtraderdaily/2012/05/22/dell-drops-7-fyql-misses-g2-rev-view-weak/) is because a PC sold by Dell is
no different than a PC sold by Hewlett-Packard, Acer, or Sony. When you're in the commodity
business, you can only compete on price, and eventually your razor thin profit margins will keep
falling while your expenses keep increasing until they reach a point where it's no longer profitable
to stay in business.

Apple succeeds because they control both the hardware and the content through iTunes. Besides
selling music, Apple is gradually branching out into video streaming (TV shows and movies) and
e-books while also providing the tools needed to entice people to support and eventually depend
on Apple.

GarageBand helps fledgling bands record music (which they can sell on iTunes), iMovie helps
people edit video, and iBooks Author helps people create e-books exclusively for Apple's
iBookstore. Amazon's Kindle Fire tablet tries to mimic the iPad while helping drive sales of
additional content, and Amazon Studios can help people turn their great ideas into a TV series or
movie.

The battle isn't over the fastest processor or the biggest hard disk any more, but in providing the
content needed to make that hardware useful. While Apple and Amazon focus on luring content
developers and consumers into their ecosystem, everyone else remains in the technology
commodity business selling nearly identical hardware at razor thin margins, and then wondering
why they're not making any money or leading their fields any longer.

Nobody worries if Apple or Amazon will lose market share soon, yet everyone worries about the
future of Research in Motion, Nokia, Dell Computers and Hewlett-Packard. Despite their profits of
billions of dollars a year, Microsoft also has everyone worried because Microsoft lacks a content
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ecosystem to attract and retain customers.

Buy a Kindle Fire and you'll likely keep shopping at Amazon to buy e-books, TV shows, or
movies. Buy an iPhone, iPad, or Macintosh, and you'll find that they work best when paired with
other Apple products, plus you'll likely continue buying apps through Apple's App Store, music
through iTunes, and possibly even e-books through Apple's iBookstore. Buy Windows 7 on a PC
and you have no reason to buy anything from Microsoft ever again.

Microsoft's shift to their own Windows 8 app store is better late than never, but they're still
missing out on the sale of music, TV shows, movies and e-books. The future of Amazon and
Apple continues to shine brightly as they profit off repeat customers buying new content. The
future of everyone else continues to grow dimmer as these other companies can only profit by
selling to a rapidly shrinking base of new customers.

In the business world, it's always cheaper to sell to an existing customer than to track down and
sell to a new customer. You can exhaust yourself trying to make sales to new customers
everyday, or you can sit back and let your existing customers send money your way on a regular
basis. Can anyone guess which business model will be easier and more lucrative in the long run?
Now can you guess which companies have a brighter future and which ones do not?

Save Your Storage Space

No matter how much storage space your hard drive might have, it will never be enough. Just as
people tend to clutter their garages with junk that they no longer need when they actually look at
it, your hard disk likely contains files you don't need after all.

Beyond getting rid of old files you no longer need, your Macintosh likely contains two major
groups of files that you can safely eliminate. First, are multiple language files. Many programs
ship with multiple languages just in case someone needs to use the program in Dutch or Russian.
Chances are good that you'll never need more than a handful of these foreign language files, so
unless you believe you'll have a sudden need to write in Greek or Arabic, you might as well wipe
out these unnecessary language files and save space.

A second type of file you can safely eliminate are half of all Universal binary files. When Apple
switched from PowerPC processors to Intel processors, they created a Universal binary file
format that essentially contains two copies of the same program. One file runs on PowerPC
processors while the second file runs on Intel processors.

No matter what type of Macintosh you have, you either have a PowerPC processor (in an older
Macintosh) or an Intel processor (in a newer Macintosh). In either case, a PowerPC Macintosh
can't use a program for the Intel processor and an Intel Macintosh can't use a PowerPC program.
By deleting either the PowerPC or Intel files, you can effectively slice a program's size in half.

While it's possible to delete foreign language files and PowerPC/Intel files by hand, it's probably
not something the average person would want to do. Instead, get a program from ProSoft
Engineering called DriveSlim (click.linksynergy.com/fs-bin/stat?
1d=15PJQz44Qcc&offerid=146261&type=3&subid=0&tmpid=1826&RD_PARM1=http%253A%252F%252Fitunes.apple.
com%252Fus%252Fapp%252Fdriveslim%252Fid474616644%253Fmt%253D12%2526u0%253D4%2526partnerld%
253D30). DriveSlim simply scans your hard disks and gives you the option of deleting different

32 of 48



ComputorEdge 6/1/12

types of files to free up space on your hard disk. Originally priced at $19.99, ProSoft Engineering
is currently selling DriveSlim through the Mac App Store for $9.99.

Figure 2. DriveSIlim makes it easy to delete unnecessary files.

DriveSlim is actually part of ProSoft Engineering's $99 Drive Genius (www.prosofteng.com/products/
drive_genius.php) program that provides more sophisticated hard disk diagnostic features. If you just
want to free up space, get DriveSlim. If you want a tool to help check for bad disk sectors in
addition to freeing up disk space, get Drive Genius. By trimming unnecessary files from your hard
disk, you can create more room to stuff more important files.

Bargain Priced Apps

The App Store can tempt people into buying everything they see like a kid in a candy shop. To
help cut costs on different apps, check the AppleSliced (applesliced.com/) site, which not only helps
track the best prices for Apple products in your area, but also keeps track of the latest app deals
for that day.
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Figure 3. AppleSliced alerts you to free or discounted prices on different apps.

Many app developers drop their prices temporarily to boost sales and attract attention to their
apps. Sometimes the prices can even drop all the way to free for a day or two, which gives you a
chance to get a commercial app for nothing. The idea is that a temporarily free app can draw
attention to the developer's other apps and ultimately increase sales.

By scanning the AppleSliced site regularly, you can snare useful apps for free or at a greatly
reduced price. Either way, you'll save money so you can use it to buy even more apps for your
iPhone, iPad, or Macintosh.

For another way to get apps inexpensively, buy them as soon as they're released. Companies
often release a new app at an introductory low price to attract attention and encourage people to
buy now before the price goes up. AutoDesk recently did this with their much anticipated
SketchBook Ink (click.linksynergy.com/fs-bin/stat?
1d=15PJQz44Qcc&offerid=146261&type=3&subid=0&tmpid=1826&RD_PARM1=http%253A%252F%252Fitunes.apple.
com%252Fus%252Fapp%252Fsketchbook-ink%252Fid526422908%253Fmt%253D8%2526u0%253D4%
2526partnerld%253D30) app, which lets you draw vector-based illustrations on an iPad. For a limited
time, you can get SketchBook Ink for $1.99. If you need an artistic tool, SketchBook Ink may be
the app you need to turn your iPad into an electronic canvas and kill the myth that the iPad can't
be used to create content once and for all.
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Figure 4. SketchBook Ink turns your iPad into an electronic canvas.

More Dinosaurs Sinking in the Tar Pits

New Orleans' newspaper, The Times-Picayune, has announced that they'll only print three editions
(www.reuters.com/article/2012/05/25/us-media-neworleans-newspaper-idUSBRE84003E20120525) a week. While
this leaves New Orleans as the first major city without a daily newspaper, it's simply inevitable as
newspapers face a shrinking future. When daily newspapers parade out yesterday's news, how
much longer can any city's daily newspaper survive? Try selling day-old bread at premium prices
and see how long that will last.

Classified ads have flocked to Craigslist while news readers can get more timely information from
the Internet rather than waiting for a newspaper to print that same information a day or two later.
In the old days, gathering and displaying news to the masses took a huge organization. Today, a
single blogger can provide more timely news to the world than any printed newspaper could
possibly do.

Instead of wasting time reading your local newspaper, grab a free copy of Zite (click.linksynergy.com/
fs-bin/stat?id=15PJQz44Qcc&offerid=146261&type=3&subid=0&tmpid=1826&RD_PARM1=http%253A%252F%
252Fitunes.apple.com%252Fus%252Fapp%?252Fzite-personalized-magazine%252Fid419752338%253Fmt%253D8%
2526u0%253D4%2526partnerld%253D30) for the iPad, which lets you choose different topics that you
want to read about. Now each time you load Zite, it displays the latest news from each of your

35 of 48



ComputorEdge 6/1/12

chosen topics to create a custom newspaper containing the topics of interest to you, which no
printed newspaper can ever match.

Figure 5. Zite lets you pick the news topics you're most interested in reading.
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Figure 6. Zite displays a custom newspaper matching your favorite topics.

The next dinosaur to bite the dust is 38 Studios (games.yahoo.com/blogs/plugged-in/curt-schilling-38-
studios-lays-off-entire-staff-223327485.html), a video game company run by former Red Sox pitcher Curt
Shilling. Amazingly, the state of Rhode Island loaned this company millions to get started
(naturally, the taxpayers always get stuck paying the bills while never enjoying any of the profits)
and they produced a single game for Electronic Arts called Kingdoms of Amalur: Reckoning (www.
amazon.com/gp/product/B0044SA70M/ref=as_li_tf tI?ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B0044SA70M), available for
Windows, Xbox and PlayStation.

The cost to produce games for dedicated video game consoles continues skyrocketing, which
limits the number of titles and the number of companies even capable of producing such games.
On the other hand, a simple game like Angry Birds, created by individual developers, could sell
for 99 cents on the iPhone or iPad and blossom into a $500 million dollar industry. As the video
game console market creeps along with innovation stifled through sheer expenses alone, the
mobile game market continues shooting forward with virtually no barrier to continuous innovation.
In comparison to Rhode Island's disastrous investment in 38 Studios, read this Forbes article
(www.forbes.com/sites/theyec/2012/05/25/how-i-launched-a-mobile-gaming-app-from-my-apartment/) about how
someone created a $200,000 a month income by launching a mobile game from an apartment.
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When the barrier to entry remains high, bloated, inefficient bureaucracies can thrive. The moment
these barriers to entry disappear, these bloated middlemen bureaucracies have nowhere to go
but down as more nimble individuals run rings around them, much like the early mammals did
against the slow-moving dinosaurs.

Thomas Friedman's book The World is Flat (www.amazon.com/gp/product/0312425074/
ref=as_li_gf sp_asin_tl?ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0312425074) discusses how
technology has reduced barriers that allow people in other countries to work together that was
impossible in the past. By flattening these barriers to entry, more people can perform work that
previously required massive corporations. As people turn to self-publishing with e-books
(eliminating print publishers), video game development (without massive video game studios), or
movie and TV series development (without Hollywood), expect more opportunities for people
guick enough to take advantage of them.

Instead of looking for a job, look for opportunities that will be far more lucrative and secure than
any corporate job could ever be. Ultimately, the only job security you'll ever have is your own
ability to produce useful results.

More 3D Printing News

Many people go back to school to get a better job. Unfortunately, the curriculum of many colleges
often lags behind the real world so if you really want to improve your chances of staying relevant,
you'll need to do a lot of self-education. One way to do that is to learn how to use popular
software such as Microsoft Office. Since the more specialized your skills, the higher the pay you
can earn, look at learning AutoCAD. Besides reading AutoCAD books, go through the free
tutorials provided by CADTutor (www.cadtutor.net/).

One huge reason to learn CAD is to take advantage of the coming 3D printing revolution. Forbes
keeps publishing numerous stories about 3D printing (www.forbes.com/sites/gcaptain/2012/03/06/will-3d-
printing-change-the-world/) such as how spaceships of the future could carry a library of 3D images of
all the spare parts they need and then print them when needed. The alternative is to lug around a
huge inventory of spare parts, which isn't practical.

Watch this Forbes video (video.forbes.com/fvn/future-tech/autodesk-on-3d-printing) with an AutoDesk
executive about the future of 3D printing in the next five years. By allowing anyone to create
physical objects with moving parts, 3D printing promises to revolutionize manufacturing. Of
course, the key to 3D printing isn't the technology but the know-how to design and modify objects
in CAD software such as AutoCAD. If you know how to use AutoCAD and other CAD programs,
you'll be in demand. Forbes predicts (www.forbes.com/sites/timccue/2012/03/27/3d-printing-industry-will-reach-
3-1-billion-worldwide-by-2016/) that 3D printing will become a $3.1 billion dollar industry by 2016 so
anyone with CAD skills will benefit.

At Disney World, you can now get your physical likeness captured as a 3D image (www.forbes.com/
sites/tjmccue/2012/05/16/star-wars-and-disney-boosting-3d-printing-industry-craze/) to create a Star Wars toy of
your own face frozen like Hans Solo in a block of carbonite. While such an application of 3D
printing is trivial, it demonstrates the potential to create custom physical objects inexpensively
and quickly.
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Organovo is currently printing human tissue (seekingalpha.com/article/428421-organovo-s-3d-bioprinting-a-
win-for-pharmaceuticals) using 3D printing technology. The ultimate goal is to print replacement
organs for people that will have zero chance of rejection since they're actual cells from your own
body. In the short-term, Organovo hopes to create tissue samples so drug companies can test
their products on real human tissue without the risk of testing on actual human subjects.

Figure 7. Organovo plans to "print" individual cells a layer at a time to create living tissue.

Anything involving 3D printing will require CAD knowledge, so anyone learning AutoCAD or
related CAD software can get a well-paying job that people with ordinary HTML or C++
programming skills can never get. Combine your CAD knowledge with a background in biology
and you'll have even more specialized skills that can translate into greater job opportunities.

Since learning 3D CAD with AutoCAD can be complicated and expensive, start out learning the
basics of 2D CAD using a free program called DraftSight (www.3ds.com/products/draftsight/overview/).
DraftSight runs on Windows, Mac OS X and Linux, and gives you plenty of features to learn 2D
CAD so you can eventually work your way up to 3D CAD.

While there will undoubtedly be those who will loudly claim that daisy wheel and dot-matrix
printers are all that anyone could possibly need, just keep looking ahead towards opportunities
created by 3D printers and you'll go farther than staying stuck in the past.

* * *

If you find the text in Safari too hard to read, change it. Load up Safari, choose Safari —>
Preferences, and when the Preferences dialog appears, click on the Appearance icon. Now you
can click on a Select button to choose a different font and font size to make Web browsing easier
on your eyes when using Safari.
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Figure 8. Set the default font and font size for Safari.

In the early days, before Wally became an Internationally renowned comedian, computer book
writer, and generally cool guy, Wally Wang used to hang around The Byte Buyer dangling
participles with Jack Dunning and go to the gym to pump iron with Dan Gookin.

Wally is responsible for the following books:

My New Mac, Lion Edition (www.amazon.com/gp/product/1593273908/ref=as_|i_tf tl?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=217145&creative=399373&creativeASIN=1593273908)

My New iPad 2 (www.amazon.com/gp/product/159327386X/ref=as_li_tf tI?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=217145&creative=399373&creative ASIN=159327386X)

Steal This Computer Book (www.amazon.com/gp/product/15932710507?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271050)

Microsoft Office 2010 For Dummies (www.amazon.com/gp/product/04704899877?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470489987)

Beginning Programming for Dummies (www.amazon.com/gp/product/04700887027?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470088702)

Beginning Programming All-in-One Reference for Dummies (www.amazon.com/gp/product/04701085417?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470108541)

Breaking Into Acting for Dummies with Larry Garrison (www.amazon.com/gp/product/07645544687?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0764554468)

Strategic Entrepreneurism with Jon and Gerald Fisher (www.amazon.com/gp/product/15907918947?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=159079189)

How to Live with a Cat (When You Really Don't Want To) (www.amazon.com/gp/product/BO06DJYL70/
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ref=as_li_tf tI?ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=217145&creative=399373&creativeASIN=B006DJYL70)

The Secrets of the Wall Street Stock Traders (www.amazon.com/gp/product/BO06DGCH4M/
ref=as_li_tf tI?ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=217145&creative=399373&creativeASIN=BO06DGCH4M)

Mac Programming For Absolute Beginners (www.amazon.com/gp/product/14302333627?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1430233362)

99% Fairy Tales (Children's Stories the 1% Tell About the Rest of Us) (www.amazon.com/gp/product/
BO0O6QSKM3A/ref=as_li_tf tlI?ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creative ASIN=BO06QSKM3A)

The Zen of Effortless Selling with Moe Abdou (www.amazon.com/gp/product/BOO6PUFPGI/ref=as_li_tf tl?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=BO06PUFPGI)

The 15-Minute Movie Method (www.amazon.com/gp/product/BO04TMD9KS8/ref=as_li_tf tI?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B004TMD9KS)

In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15
Minute Movie Method. (www.15minutemoviemethod.com/)" Wally can be reached at wally@computoredge.
com.
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Beyond Personal
Computing
“Treacherous Tales of
Misunderstood Screen
Savers” by Marilyn K. Martin

Amusing anecdotes about screen savers
and how they are used.

When personal computers first burst on the public scene, we were all duly warned to use a
screen saver. These were computer programs to prevent phosphor burn-in (or ghosts images) on
CRT and plasma computer monitors. Initially, they were built-in programs to just blank the screen
when the computer was on but unused for so many minutes. And the confusion took off from
there...

Into The Blackness

"My computer is dead!" reported an alarmed employee to a tech-savvy friend a few cubicles
down. "I left my computer on to just go get some coffee. | come back—the screen's black!" The
friend checked to see that the power was on with no flashing red lights. He touched the mouse
and snap! the screen came back on. "What did you do?" gasped the grateful friend. "I moved the
mouse," the friend shrugged. "That black screen was just your screen saver."

An employee called their Tech Support to report a dead computer. The machine was on, he
reported, but the screen was blank and nothing would wake it up, not even moving the mouse.
The Tech arrived to find that the keyboard had become disconnected, and ten minutes later, the
screen saver had activated.

A student walked into a Computer Lab, and was pointed to a free computer. She sat down, then
called out, "But the screen is dark.”" The Lab Administrator tried to be helpful. "The computer is
on, so that's just the screen saver. Press any button, and it'll go away." She pressed the Power
button. "OK, but it's still dark!"

A worried father approached his tech-savvy teen. "I left my computer on, and came downstairs
for ten minutes. | go back up, and my computer has turned itself off! Is it broken?" The teen
checked it out, and the monitor screen popped back on. "No, it's not broken, Dad. It's called a
screen saver."
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Logos and Lost Egos

Then computer companies started experimenting with a little advertising, programming in moving-
logos over darkened screens as screen savers. This at least told most users that their computer
was on, and the monitor ready for input. But the confusion didn't stop there.

A customer called up their computer company's Help Desk. "I ran your DSL installation CD, and it
broke my computer!" he sputtered. "It is restarted, and is now stuck at the Windows XP logo. It's
been like that for over an hour." The Tech at the Help Desk suggested he reboot, and the
customer then got a log in prompt. "OK, now the installation is running," the customer reported.
"So why was my computer stuck like that at start-up?" The Tech asked, "Was the Windows XP
logo changing positions every couple seconds?" When the customer said Yes, the Tech
explained that his computer wasn't broken—he'd really just been staring at the screen saver for
an hour.

Tech Support was on the phone one day with a lady learning to send e-mail. "OK, now do you
see the 'To:' field on your e-mail message? So type in the e-mail address it's going to." The
customer hit the wrong button. "Ooops! Where did it go? Oh no! What's happening to my
computer?" The Tech calmed her down and asked what was on the screen. "All these flying
window things are coming out of nowhere!" she gasped. "They're going all over my screen, but...
they're kinda pretty too." The Tech sighed and told her that the "flying windows" was just the
screen saver, and they got back to the e-mail instructions.

A young man had a girlfriend who absolutely loved a particular animated movie, and downloaded
the free screen saver from the animation company. A month later, the boyfriend logged onto her
computer to use the word processor. Suddenly he noticed the title of the animated movie faintly
at the bottom of his document, which had burned into the screen. He wasn't sure if this was
accidental or deliberate on the part of the animation company. The screen saver really hadn't
"saved" the screen—but was doing a dandy job of unobtrusive advertising.

Possessed Screen savers

Tech Support got a call one day from a panicked user. He'd left his computer for a few minutes,
and came back to discover that "The Devil has possessed my computer!" He reported that it was
bubbling all over the place, and the Devil was in his monitor. The Tech calmly asked the man to
move the mouse. The Devil and his bubbles left. It was just a screen saver.

A teen's mother frequently left her work computer on overnight. One day she installed a new
screen saver with some interesting noises, and left the computer on overnight. When the cleaning
lady tidied up that night, she thought the office was possessed by ghosts, and thereafter totally
refused to clean that office.

Bad Computer? Or New Screen Saver?

A young man sold his old computer to a friend of a friend, who never called him again. Running
into him months later, the young man asked how his old computer was working. "Oh, | threw it
away. It was a piece of junk," the acquaintance reported. "Every time | stopped typing for awhile,
the image on the screen started to melt and slip to the bottom." Even though everything popped
back to normal when he touched the keyboard or mouse, he was convinced it was defective and
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threw it away. Apparently, the young seller had forgotten to tell him about the Screen Melt FX
screen saver.

An upset customer called Tech Support: "I have a very big problem! If you don't help me right
now, | will return the computer!" The Tech asked what the problem was. "My friend just installed a
screen saver on my computer. But every time | move the mouse—the screen saver disappears!"

Another employee called up Tech Support to declare, "My computer blew up!" When the Tech
arrived, he had to calm the employee down. "It's just an animated screen saver called Starfield,
Sir."

A customer called up Tech Support in a panic: "You've got to help me! | can't believe what's
happening on my monitor! It's all upside down, and it's swirling! | think this monitor is bad, or
something has taken over my computer. It's just so weird!" The Tech calmly explained that it was
just a screen saver.

Extreme Screen Saver Tech 3.0

A student dropped by his school's computer lab, and asked the Lab Techs if they could make
lasers shoot out of a monitor screen—the kind of lasers that could blind you. The flabbergasted
Lab Techs said no, this wasn't possible. The student insisted it was possible, because he has
seen it on his sister's computer screen. One of the Lab Techs then realized he'd seen something
similar—as a Windows screen saver.

An employee popped into the next cubicle to say, "Hi! My screen saver has fallen off my monitor
and hit the keyboard. Then everything locked up. Can you tell me how to fix it?" The coworker
discovered that the polarized screen filter on the monitor had fallen off and hit the scroll lock key.

A customer called up Tech Support. "How do | remove the screen saver?" the anxious customer
asked. "Do | just go to My Computer and delete everything?"

Modern Screen Fashion

Today, most monitor screens are LCD, and the ghost-image problems from old CRT screens has
been eliminated. Most newer computers come with a selection of attractive photos or artwork as
screen backgrounds (or wallpaper), that eliminate the need for screen savers. Although
downloadable screen savers for youngsters can feature animation tied to glittery cursors that can
regularly be changed. For adults, downloadable screen savers or wallpaper can feature up-to-
date news, stocks, a video game or just an attractive clock feature. But still not everyone's up to
speed on screen savers or backgrounds.

A helpful employee put a Movie Magic screen saver on her boss' computer. The manager was
duly impressed by the "nice pictures," and asked if she could set the screen saver so the pictures
don't change, just featuring the one he liked best. "Oh, you mean you'd like this as wallpaper?"
the employee asked. "No!" answered the Manager testily. "I don't want you to start decorating my
office, just make that one picture stay put on my monitor screen!"

(Many of these amusing anecdotes are on multiple Internet joke sites. But special thanks to
Rinkworks.com (Rinkworks.com) and their Computer Stupidities.)

44 of 48



ComputorEdge 6/1/12

Marilyn is a freelance writer and humorist, with a special interest (besides computers and
technology) in Science Fiction. A SF Horror story appeared in July 2011 in Deadman's Tome
(www.demonictome.com/). And in January 2012 she had a SF Police Procedural appearing in Cosmic
Crime magazine, and a SF Dystopian Romance appearing in the Strange Valentines anthology. She
also has almost seventy articles on Helium.com (www.helium.com/users/573405/show_articles), and is
writing a humorous Young Adult SF series, Chronicles of Mathias (www.amazon.com/Chronicles-
Mathias-One-Reptilian-Rebirth/dp/1598249002). Volumes One and Two have received a "Gold
Star for Excellence" from TeensReadToo.com (www.teensreadtoo.com/ReptilianRebirth.html), and are
available from most on-line bookstores.

ComputorEdge E-Books has converted many of Marilyn's computer humor columns into four e-
books.

* Computer Confusion in Paradise: Lo! And in the Beginning There Was Total Befuddlement!, in both EPUB
format (www.computoredgebooks.com/Computer-Confusion-in-Paradise-humor-EPUB-iPad-NOOK-
COMPHUMORO0001-1.htm?sourceCode=writer) for iPad, NOOK, etc., and MOBI format (www.
computoredgebooks.com/Computer-Confusion-in-Paradise-humor-MOBI-for-Kindle-COMPHUMORO0001-2.htm?
sourceCode=writer) for Amazon Kindle.

* Computer Hardware: "Parts Is Parts”, in both EPUB format (www.computoredgebooks.com/Computer-
Hardware-Parts-Is-Parts-humor-EPUB-iPad-NOOK-COMPHUMORO0002-1.htm?sourceCode=writer) for iPad,
NOOK, etc., and MOBI format (www.computoredgebooks.com/Computer-Hardware-Parts-Is-Parts-humor-MOBI-
for-Kindle-COMPHUMORO0002-2.htm?sourceCode=writer) for Amazon Kindle.

* Computerholics Anonymous: PC Users, Abusers and Confusioners, in both EPUB format (www.
computoredgebooks.com/Computerholics-Anonymous-humor-EPUB-iPad-NOOK-COMPHUMORO0003-1.htm?
sourceCode=writer) for iPad, NOOK, etc., and MOBI format (www.computoredgebooks.com/Computerholics-
Anonymous-humor-MOBI-for-Kindle-COMPHUMORO0003-2.htm?sourceCode=writer) for Amazon Kindle.

* My Computer, My Nemesis: Bravely into the Smiley-Face Virtual Void!, in both EPUB format (www.
computoredgebooks.com/My-Computer-My-Nemesis-humor-EPUB-iPad-NOOK-COMPHUMORO0004-1.htm?
sourceCode=writer) for iPad, NOOK, etc., and MOBI format (www.computoredgebooks.com/My-Computer-
My-Nemesis-humor-MOBI-for-Kindle-COMPHUMORO0004-2.htm?sourceCode=writer) for Amazon Kindle.

* All four e-books can be found at our E-Book Store (www.computoredgebooks.com/Humor-Computer-and-
Internet-Anecdotes-and-Jokes_c16.htm?sourceCode=writer).
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Return to Table of Contents

Editor's Letters: Tips and Thoughts
from Readers

“Computer and Internet tips, plus comments
on the articles and columns.” by ComputorEdge Staff

"Zone Alarm Bug," "Who Uses Smartphones”

Zone Alarm Bug
[Regarding the May 11 ComputorQuick Reviews column:]

Yep, bit me real hard. Got the pop-up to take the free upgrade and did so. From there it was all
down hill. Had to remove the program and install another. Could not report bug either.

-Leslie, Elizabeth, CO

Update: Sky and Telescope interactive sky chart won't work (requires Java) and Scottrader
Streaming Quotes won't work (also use Java) until you "exit" Zone Alarm. There maybe some
settings in Zone Alarm that could be changed to allow Java to work on those sites. | don't know
what they are yet.

-Walter, San Diego, CA

Who Uses Smartphones

[Regarding the May 11 Wally Wangs Apple Farm column:]
Jeez, Wally,

You make it sound like white people don't have much buying power compared to other ethnicities
when you start using percentages in your article. But by my calculations, white people still have
quite a bit of buying power. Using Wikipedia's published Demographics of the United States, |
come up with some interesting numbers. It seems that even though white people may be buying
in smaller percentages, the total number of white people buying smartphones is still larger than
the number of of the other ethnicities put together.

By my calculations (using your percentages), it breaks down to:

Population  Smart% Total
White 223553265 44.7 99928309
Black 38929319 54.4 21177550
Asian 14674251  67.3 9875771
Hispanic 50477594  57.3 28923661
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For your information, yes, | am white. Yes, | have a smartphone, and yes, | have a Mac, (And a
Windows XP Netbook, and a Windows 7 Desktop, and a Linux Laptop) and will be buying my
daughter a Mac laptop for one of her graduation presents.

Like in most aspects of life, | find diversity very refreshing.
-RC Hamer, Lake Elsinore, CA
Hello RC,

Thanks for writing and reading my column. Basically what | meant in my last column was that Nielsen (not me) came
up with that odd statistic about smartphone ownership by race. | just thought it odd enough to put in and now I'm sorry
that | did since the issue of race seems to have touched off an emotional nerve on everyone.

| think what most people are mistaking (beyond thinking that I made up Nielsen's statistics) is that greater smartphone
ownership somehow implies superiority, which makes as much sense as saying greater dishwasher ownership implies
superiority somehow. Take away the issue of race and replace them with nonsensical groupings like "People who like
hot dogs" or "People who like the color purple" and plug them into the same smartphone statistics and you can better
see the oddity of the data, which does not imply or conclude any type of superiority to any particular group, but simply
shows the breakdown of smartphone ownership among different people.

Yes, diversity is very refreshing. What's more refreshing is when people are able to communicate civilly and seek
clarity rather than jump to accusations right away, and for that, | thank you for the tone and content of your message.

-Wally Wang

What a great statistic! Thanks, Wally. Those numbers are an eye-opener, especially since | don't
see many smartphones among my acquaintances. But I'm white (the lowest usage percentage)
as are most of those | know. (Of course, being a cheapskate also has something to do with it!)

Is it possible that corporations own a sizable number of smartphones, thus hiding the actual
users' ethnicity?

If you see more research like this, please publish it.

-Peter, Los Angeles

ComputorEdge always wants to hear from you, our readers. If you have specific comments about
one of our articles, please click the "Tell us what you think about this article!" link at the top or
bottom of the specific article/column at ComputorEdge.com (webserver.computoredge.com/online.mvc?
src=ebook). Your comments will be attached to the column and may appear at a later time in the
"Editor's Letters" section.If you want to submit a short "ComputorQuick Review", or yell at us,
please e-mail us at ceeditor@computoredge.com. If you would like to review our recent e-books,
please visit ComputorEdge E-Books (www.computoredgebooks.com/).
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Send mail to ceeditor@computoredge.com with questions about editorial content.
Send mail to cewebmaster@computoredge.com with questions or comments about this Web site.
Copyright © 1997-2012 The Byte Buyer, Inc.

ComputorEdge Magazine, P.O. Box 83086, San Diego, CA 92138. (858) 573-0315
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